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Hints and Tips for
Using this CD-ROM

Skim through this Quick Start
Guide and familiarize yourself
with the CD-ROM contents and
capabilities.

View the tutorial movies.  A tour
of the CD-ROM is provided on
 the first menu screen, and the
 others are provided under the
  “Show me the data” menu,
   then “Browser Basics.”

Work through the Hands-On
Guided Tour by clicking on the
“Show me the data” menu
choice, then click on the
“Browser Basics” menu choice.
This demo provides step by step
instructions for you to print and
work through at your own pace.

Send your questions to
ACS@census.gov

We would also like to hear your
comments about the CD-ROM and
your suggestions for future
improvements. Since the American
Community Survey provides data
every year, we have built
continuous improvement into the
program.  Please send your
comments to the address above.

Check out the American
Community Survey Internet site
at http://www.census.gov/acs/
www

A wealth of information
to meet your needs...
The American Community Survey
CD-ROM is just one of the many
products offering social,
demographic, and economic
information from the U.S. Census
Bureau.  Take a look at these other
Census Bureau products that you
can use, along with the American
Community Survey data, to give
you the most current, accurate
picture of social and economic
conditions in your community
and the country.

•  Statistical Abstract 1997:
You can use this to create a
general portrait of America for
recent years plus find valuable
resources that tell you where to
go for additional information.

•  LandView III: You can use this
electronic atlas to draw maps
showing social and economic
characteristics or find locations or
streets on a map.

•  County Business Patterns:
This product helps you find data
by 2-,3-, and 4-digit Standard

Industrial Classification codes on
total number of establishments,
mid-March employment, first
quarter and annual payroll, and
number of establishments by
employment-size classes.

•  State and Metropolitan Area
Data Book: You can use this book
to find 1990 census population
and land area for all areas covered.
For the United States, regions,
divisions, and States, the report
also features 1990 census race,
Hispanic origin, household, and
housing counts. Also, the tables
summarize data from the
economic censuses and continuing
demographic and economic
surveys. The report also includes
data from other governmental and
private agencies.

•  CountyScope: This custom
product helps you compile data
from over 12 leading Census
Bureau products.
For more information visit us on the
Internet at http://www.census.gov or
call our Customer Services Center on
301-457-4100.



BEFORE YOU START
    What is the American Community Survey
    What is on this CD-ROM
    Beyond 20/20 Browser Concepts

GETTING STARTED
    Finding the Data You Need
    Opening a Table or Extract

WORKING WITH TABLES
    Understanding the Table
    Charting and Mapping Data
    Saving and Printing

WORKING WITH EXTRACTS
OTHER TABLE CREATION FEATURES
MORE ON GEOGRAPHY AND MAPS
OTHER CENSUS BUREAU PRODUCTS

Beyond 20/20, Beyond 20/20 Browser, Beyond 20/20 Builder, Beyond 20/20 Distributor, ChartBrowse
and MapBrowse, the Beyond 20/20 slogan, and the Ivation logo: all are trademarks of Ivation Datasystems
Incorporated.

dBASE® is a registered trademark of Ashton-Tate Corporation.
Lotus® and 1-2-3® are registered trademarks of Lotus Development Corporation.
Microsoft® and the Microsoft Internet Explorer logo are registered trademarks of Microsoft Corporation
in the United States and/or other countries.
All other registered and unregistered trademarks are the property of their respective holders.

Graphics created by Administrative and Customer Services Division,
BUREAU OF THE CENSUS

Portions of this 1997 American Community Survey CD-ROM include software used under license from
Ivation Data Systems, Inc., Lotus Development Corporation, Adobe, and Microsoft Corporation. These
software programs are subject to copyright restrictions. Permission to reproduce or distribute copyrighted
material must be obtained directly from the copyright owner.

The  Census Bureau's American Community Survey data; profiles, summary tables, charts, and maps
created from the data; and all supporting documentation are not subject to copyright restrictions.

  3
4

  5

  6
  7

7-12
    13-15

15-16

16
19
20
21



What is the American Community Survey
Your Community’s Key to the Future...

For years, communities have been
asking for more timely information
for local planning and economic
development.  In response, the
Census Bureau is developing the
American Community Survey (ACS),
a survey that will give you up-to-date
economic, demographic, social, and
housing profiles of America’s
communities every year instead of
once every ten years.

This timely data will help community
leaders make informed decisions
about their community’s future that
are based on current conditions
rather than outdated information.
Communities can use the information
to plan for economic development;
to make decisions about locating
schools, hospitals, and roads; and
to compare their situation with other
communities.

New sites will gradually be added to
the American Community Survey
until 2003 when it will be launched
nationwide.  The survey will provide
estimates of housing, social, and
economic characteristics every year
for all states, as well as for cities,
counties, metropolitan areas, and
population groups of 65,000 persons
or more.  For small areas and
population groups of 15,000 or less,
it will take five years to accumulate
information to provide accurate
estimates.  Once the survey is in full
operation, the estimates will be
updated every year for every
governmental unit, for components
of the population, and for census
tracts and block groups.

3



What’s on the American Community
Survey 1997 CD-ROM?

■ The ACS... What it is; Why we do it; How we do it: 
A description of the American Community Survey and 
information about how the data are collected and processed

■ Tell me about the survey: The survey questionnaire

■ Answer me this: Frequently asked questions and answers
to help you understand the survey

■ Show me the data: A wealth of data from the survey 

Profiles of social and economic characteristics 
for each site

Summary tables similar to those from the census

Public Use Microdata Sample (PUMS) for research 
and special purposes

■ Also under Show me the data:  A Hands-On Tour, Quick
Start Guide, and tutorial “movies’’ about how to use the 
Beyond 20/20 software to find the information you need
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Beyond 20/20
Concepts
A table is an integrated
presentation of multi-dimensional
data and descriptive text prepared
with the Beyond 20/20 Builder.
Tables are composed of
descriptive components,
dimension field information,
and data values. When a table
is opened, the Browser presents
the data in a table view.
A dimension describes an
attribute of the table data, e.g. sex,
geography, or time. Beyond 20/20
tables can have up to eight
dimensions.
An item is an element of a
dimension, e.g. June is an item of
the time dimension; and Male, of
the sex dimension.
A label is a title or display heading
of an item. An item can have more
than one label although you see

only one label at a time, e.g.,
United States is a label for the
code “U.S.”
An extract is a special type of
database file that is created with
the Beyond 20/20 Builder. It is a
preprocessed form of a microdata
file and is optimized to permit rapid
table creation with the Browser.
You can create a table by opening
an extract, defining the dimensions
and contents of the table, and
clicking on the Go button in
the toolbar.
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Looking at the Data
To start the Beyond 20/20
Browser, double-click on “Show
me the data” on the first menu
screen. Then click on “Summary
Tables” or “Public Use Microdata
Sample” (PUMS) files. By
default, when the Browser
opens, the Find dialog box
appears to provide you with a
quick and easy way to find and
open a table or an extract.

Finding a Table or
an Extract

If you're not already in
the Find dialog box, 
click on the Find button
in the toolbar.

Confirm or modify the path
shown in the Directory box so
that it’s pointing to the directory
that contains the tables and/or
extracts you want to browse:
   b2020/data/tables
   b2020/data/extracts
Select the categories that most
likely contain the table or extract
you need. A list of tables and
extracts belonging to that
category is displayed.
Note:  If you want to see more
information about what a
particular table or extract
contains, click on its name and
choose the Summary button.
You can also use the Search
button to find tables or extracts
containing keywords.

GETTING STARTED
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Table Browsing
Once you have opened a table, you can browse through the items
in any dimension. First you must make the dimension active
                                                                     by clicking on one
                                                                     of the dimension
                                                                     tiles in the
                                                                     Dimension bar.
                                                                     You'll notice that the
                                                                     dimension is now
                                                                     shown in the Active
                                                                     Dimension box.
                                                                     Click the Previous
                                                                     Item button or the
                                                                     Next Item button to
                                                                     browse through the
                                                                     data for the items in
                                                                     that dimension. Note
                                                                     that each dimension
                                                                     tile shows the
dimension name and the code or label of the item for which data
is currently displayed.

Opening a Table or an Extract
Open a Beyond 20/20 table or extract by double-clicking on its
name in the Find dialog box.
Note:  To browse the tables you create from an extract, see
“Working with Tables” below.

WORKING WITH TABLES
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Viewing Table, Dimension and Item Summaries
Summaries give additional information about the data you are
viewing.
File summaries explain what’s in a table, and can be viewed by
selecting Summary from the file menu.

Dimension summaries can provide a description of the variable,
an explanation about where and how the source data was collected,
or reasons for any anomalies in the data.

Item summaries provide an extended description of the active
item, and they are typically used to give reasons for any anomalies
in the data.

View dimension or item summaries by clicking on the blue underline.
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Switching Table
Dimensions
Once you have opened a table,
you are in the table view. You
can change your view of the
table by dragging and dropping
dimension tiles with the mouse,
one at a time. For example, if
you want to see Poverty
Status for the current
geography, drag the Poverty
Status dimension tile and
drop it on the Geography
dimension tile.

Nesting Table
Dimensions
You can view more than one
dimension at the same time along
either the rows or the columns by
nesting dimensions. Nesting means
showing one dimension within
another. With the left mouse button
depressed, slowly drag the desired
dimension tile from the Dimension
bar to the top or bottom edge of the
column labels, or to the right or left

edge of the row labels, until a thick
line (or highlight) appears. Release
the mouse button to nest the dragged
dimension.

In the example above, the Poverty
Status dimension tile is dragged on
top of the Geography column. Now,
to nest the table, drag the family type
dimension tile until it hits the right
edge of the row labels and the
highlight appears.

The left mouse button is released,
and the Family Type dimension is
nested inside the Poverty Status
dimension.  (See next page)
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To reduce the amount
of displayed data, to
move data to another
application, or to chart
or map data, you first
need to select it.
■ To select a row or a column of 

data, click on the corresponding 
row or column heading.

■ To select multiple consecutive 
rows or columns, drag the mouse
across the row or column 
headings.

■ To select nonadjacent rows 
and/or columns, press the CTRL
key while you click on the row 
and/or column headings.

With your selection highlighted,
click on the right mouse button for
the shortcut menu, then select the
desired operation. You can show,
hide, chart, copy or print the selected
items.

Selecting Data
from a Table
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Displaying Alternate
Item Labels

Frequently there is more
than one set of labels
available for the items
in a dimension. For
example, there may be

a short label and a longer more
descriptive label. To view the next
set of labels for a dimension:
1. Make the dimension active

by clicking on the appropriate 
dimension tile.

2. Click on the Change Labels 
button in the toolbar.

Searching for Items
Along a Dimension

You can reduce the items
shown along a dimension
by displaying only the ones
you want. To search for
items along a dimension:

1. Make the dimension active by 
clicking on the appropriate 
dimension tile.

2. Click on the Search Dimension
button in the toolbar.

3. In the Search dialog box, click 
on the Data field if you want to 
search the data, then enter 
minimum and/or maximum 
values to constrain your search.
When you choose OK, Beyond 
20/20 searches the active items
and shows only those items that
have satisfied your criteria.

OR
In the Search dialog box, click
on the field you want to search,
then enter the text string that you
want to search for in the Text to
Find box. When you choose OK,
Beyond 20/20 searches the field
you selected and shows only
those items that contain the text
string specified.

Note: To jump to a desired item along a
dimension, choose Find Next.
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Sorting Data Across
a Dimension

You can sort items across
a dimension to reorder them
in the table view. To sort
items across a dimension:

1. Make the dimension active by 
clicking on the appropriate 
dimension tile.

2. Click on the Sort Dimension 
button in the toolbar.

3. If you want to sort the 
dimension based on the data 
values, click on the Data field 
in the Sort dialog box. Then 
click on either Increasing or 
Decreasing, and choose OK.

OR
If you want to sort the 
dimension based on the codes 
or labels associated with it, click
on the field that you want to 
sort, then indicate the Sort 
Option and choose OK.

Changing the
Frequency of the
Displayed Data
Many tables use time as a
dimension. You may want to
decrease the display frequency by
aggregating the data. For example,
if your table contains monthly data,
you can average or sum the monthly
values to produce annual data. To
change the frequency of displayed
table data:
1. Choose Time Series from the 

View menu.
2. Click on the desired Display 

Frequency.
3. Select the Aggregation 

Method you want Beyond 20/20
to use to compute the new 
data.

4. Choose OK.

12



Creating Percentage
Distributions
You can display numeric values
distributed as percentages of row, 
column, or table totals.
1. Choose Distributions from the
    View menu.
2. Select the dimension you
    want to include in the distribution
    calculation.  Note that the row and
    column dimensions are
    automatically included in the
    distribution calculation.
3. Clear any check boxes for those
    items you want to exclude from
    the new distribution dimension.
4. Click OK.
Beyond 20/20 creates a new table
view with a new dimension called
Distributions.  This dimension contains
one item for each type of distribution
you’ve selected.

Performing Calculations
You can apply formulas to items in a
dimension to create a computed
group.  For example, you can sum
two items together and divide the
results by two.

1. Choose Define Group from the 
Item menu.

2. Enter a unique name or group 
code represent the result of the 
formula.

3. Choose the Computed Group 
Type.

4. Enter a formula to describe how 
the new group is to be calculated.

 For example, (item1+item2)/2.
5. Click OK and proceed with 

calculation of the group.

Charting Data
  You can choose from many
    chart types to display table
   data. To create a chart:
  1.  Select the rows and/or

    columns that you want to chart.
2.  Click on the Display Chart button
     in the toolbar.
3.  With the mouse pointer in the
     chart view, click on the right
     mouse button to see the Charting
     shortcut menu.
4.  Choose Chart Options to change
     the current chart type.
5.  Make a selection and click OK to
     return to the chart view.
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ChartBrowse
The ChartBrowse
feature lets you view a
series of charts in rapid
succession so that you

can quickly and easily see trends
and variations in the data.
1.  With the mouse pointer in the
     chart view, select one of the
      headings in the title of the chart
     to make that dimension active.
2.  Use the Previous Item and Next
     Item buttons in the toolbar to
      chart the previous or next item.

Mapping Data
Some tables that have a geographic
dimension have maps associated
with them. To view the table data
within its geographic context:
1. In a table view, move the 

cursor to the item that 
contains the data you 
want to display on a map.

2. Click on the Display Map
button in the toolbar.

Zooming In and Out
of a Map View
To zoom in to a region on a map,
double-click on the region or the
value representing that region.
To zoom out to a higher level on
a map, double-click on the white
space inside the map border.

Changing Map Colors
1. With the mouse pointer in the 

map view, click the right mouse
button to see the Mapping 
shortcut menu.

2. Choose Map Options.
3. Click on the radio button in

the Range Definition area that
corresponds to the preferred 
method of data classification.

4. Use the Range Colors pop-
down menus to select the colors
that you want to appear on your
map.
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MapBrowse
The MapBrowse feature lets you
view a series of maps in rapid
succession for data tables that
support mapping. This feature
provides a quick, easy way to view
the trends and variations of the data.
1.   With the mouse pointer in the
      map view, click on one of the
      headings in the title of the map
      to make that dimension active.
2.  Use the Previous Item and the
     Next Item buttons in the toolbar
     to display the previous or next
      item on the map.

Saving and
Opening Views
A saved view is a personalized
snapshot of a table that allows you
to quickly recall a specific layout of
a table without having to redefine its
attributes.  Dimension order and
nesting, item selections, column
widths, decimal settings and time

series aggregations are all examples
of attributes that are stored in a view.
■  To permanently change the default
view of a table, you must have
permission to modify the table.
Arrange the table in the layout you
wish to save and choose Save from
the view menu.  The next time you
open the table the saved view will
automatically appear.
■  If you are in a read-only table or
you don’t want to permanently modify
the default view of a table:
1.  Arrange the table in the layout
     you wish to save.
2.  Choose Save As from the File
     menu and clear the Include
     Numeric Data check box.
3.  Name the view and specify its
     location.
4.  Click OK.
A view saved in this fashion can be
recalled by choosing Open from the
View menu and selecting the view
filename.  This method of saving a
view can also be used to save
multiple views for one table.
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Printing a Table,
Chart or Map
To print a table view, chart view, or
map view, click on the right mouse
button to see the shortcut menu and
select the Print option.

Saving a Table
To save a table (or a subset of one)
as a new Beyond 20/20 table, choose
Save As from the File menu. You can
also save Beyond 20/20 table data in
several other formats including, dBase
(.dbf), comma-separated value (.csv),
and Lotus (.wks). When saving to any
non-Beyond 20/20 format, you’ll need
to nest all the dimensions along the
rows and/or columns before you save
if you want to retain the data for these
dimensions (see “Nesting Table
Dimensions’’ on page 9).
When you open an extract, (see
“Opening a Table or an Extract” on page
7), the Browser displays an empty table
view and the Source Field bar – a list
of source field tiles down the right side
of the screen. Each source field tile
represents one of the fields in the
original data file.

Viewing Extract and
Source Field Summaries
An extract summary contains
descriptive information about the extract
and lists the attributes of the extract
along with the fields it contains. Choose
Extract Summary from the Data menu
to view the summary information.
A source field summary contains
descriptive information about a particular
source field. To view this information,
right click on a source field tile and
select Source Field Summary.

WORKING WITH
EXTRACTS
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Finding Source Fields
Source fields are the components of
an extract. When positioned into an
empty table view, they become the
dimension of a table or define the
content of a table. Often you have a
large number of source fields to work
with and you need a way to find
specific fields. The Find Source Field
dialog box helps you to do this.
1.  Choose Find Source from the 
      Data menu. Initially, all categories
     and consequently all source
     fields are displayed.
2.   Locate a particular field by
     searching for the field using the
     Search button or by selecting
     individual categories that may
     contain the source field you are
     looking for.
3.  Once you have found a specific
     source field, select it and click
     OK.  In the Source Field bar the
     Browser will position the cursor
     on the selected field.

Defining the Dimensions
of a Table
Define the dimensions of a table by
dragging your choice of source field

tiles, one at a time, into the row and
column dimension area.
1.  Drag a source field tile into the
     row dimension area. You’ll see
     that Browser highlights the area
     where the tile can be dropped.
2.  Drag a second tile into the column
     dimension area.
3.  Drag up to eight more source field
     tiles into the Dimension bar.

Filling a Table with
Units
If you want the table to be filled
with counts, you can create them
by clicking on the Go button in the
toolbar. However, you may want
to have other data values aside
from counts in the table. Just drag
and drop tiles associated with
numeric values into the cell area
of the table view. Beyond 20/20
creates a new dimension called
Units containing one item for each
tile you move into the cell area. As
you drop the tiles, Beyond 20/20
lets you choose which statistical
value related to the source field
will be used to fill
the table.
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Applying Weighting
Factor to the Data
If you are working with an extract
that represents data collected from
a survey there will probably be at
least one field that contains
weights. These weights are used
to generate population-based
tables from sample survey data.
An extract is pre-weighted if one
of the weight fields is greyed out in
the Source Field bar. Tables built
from a pre-weighted extract will
automatically contain weighted
values.  To set a weight field or to
clear or change a previously set
weight:
1.  Choose Set Weight Field from
     the Data menu.
2.  Select or clear the Use Weight
      Field check box and if selected,
     click on the numeric source
     field that you want to use as
     the weight field.
3.  Click OK.

Creating a Table
Once you've defined the table,

create it by clicking on the
Go button in the toolbar.

Saving a Table
To save your table for future use:
1. Choose Save As from the

File menu.
2. Enter up to eight characters

to name the table.
3. Choose OK.

Documenting a Table
1. Choose Summary from the Edit

menu, then choose File.
2. Enter a title and Category these

will appear in the Find dialog box.
3. If you wish, enter Keywords to 

help you find the table later, and
Notes to provide additional 
information.

4. Choose OK.



Other Table
Creation Features
The Data menu contains commands
that you can use to further customize
your table.
■ The Define Recode command

lets you create a new source field
tile based on an existing coded
field such as occupation or marital
status. Use this feature to combine
items from an original source field.
For example, for the source field
Marital Status, the codes for
Single, Divorced and Widowed
could be combined to form a new
code called Unmarried.

■ The Define Bands command lets
you create a new source field tile
based on an existing numeric field.
Use this feature to redefine the
default bands of an existing source
field. For example, if Age is a
source field, then you may wish
to change five-year bands to ten-
year bands.

■ The Define Derived Field
command lets you create a new
source field tile using arithmetic
operations on one or more existing
source fields. For example, given
Net Income and Taxes as two
source fields, you can add them
together to create a new tile called
Gross Income.

■ The Record Constraints
command lets you create a table
subject to certain criteria or
constraints. For example, if Sex
and Age are two of your source
fields, you could create a table that
contains data only for females
between the ages of 15 and 24.

See the On-line Help or the “Beyond
20/20 Browser User's Guide” at
www.ivation.com for further
information on how to use these
commands.
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Block Group Data
Block group data for the 1996
American Community Survey
sites are available on this CD-
ROM.  If you wish to work with
these data, please contact Elaine
Quesinberry on 301-457-3109
for instructions on how to access
these data.

These data are estimates from
a sample of households.  As
such, the smaller the population
size, the larger the sampling
error.  Usually, block groups
have a small population, and
usually they are not appropriate
as individual units of analysis
because of their large sampling
variance.  We provide block
group data so you can aggregate
them into larger geographic
districts that are not provided
here as a standard product (for
example, a water district, a

hospital service district, or the
service district of a business).
NOTE:  To see a detailed
explanation go to the first screen
on the CD-ROM and choose
"The nitty gritty of data
collection"...then "Accuracy of
the Data."

Maps
When using the maps, please
note that the original boundary
coordinates were extracted from
the Census Bureau's
TIGER/Line  files to create tract
outline files.  The map
boundaries have been simplified
to speed display of the maps.
For information on obtaining
more detailed maps from the
Census Bureau, please call
our Customer Services Center
on 301-457-4100.

For More information...
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